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Introduction



What is an ecosystem?

All collaterals required to develop with an MCU

Hardware Development

Tools

Evaluation boards

Debug  and Programming Probes

Software Development

Tools

Configuration Tools

Development & Debugging Tools

Monitoring Tools

Embedded Software

Drivers

RTOS

Stacks and Application Bricks

Services

Web site

Product selectors

Communities & Social Media

In the Field services

Ecosystem

ST-designed

Open source

Partners



Case study – smart watch



Sen

• Smart watches can contain:

• Processing microcontroller 

• Connectivity over BLE 

• Sensors – Gyroscope, 
Accelerometer

• Charger – USB Type C

• LCD display with touch screen

• Microphone 

• Optional 

• NFC connectivity

• Heart rate sensor

Typical block diagram of smart watch

GPS

Teseo-LIV3F

Serial Flash

Color LCD Display 

Microphone MP3

Charger

Battery

USART, SPI,

I²C

TFT 
controller

USB

SAI/I²S

ADC/GPIO

Bluetooth

STM32WB, 

BlueNRG

STNS01

STC4054, STBC08

LDO
STLQ015

Sensors
ISM330DHCX 

LSM6DSO, 

IIS2MDC



The STM32 Open Development Environment (ODE)

The STM32 Open Development Environment (STM32 ODE) allows developers to verify their design 

assumptions and move quickly from ideas to a proof-of-concept.

It leverages the STM32 MCU hardware and software ecosystem.

STM32 ODE offers a comprehensive choice of hardware, firmware and software for the function 

required by the application. 



STM32 ODE synopsis

Nucleo & X-Nucleo Boards Solution Boards

Drivers and Hardware Abstraction Layer API

Middleware

Function Pack with application examples

73

64 STM32 Nucleo development boards 
Covering the broad portfolio of STM32 MCU families 

STM32 Nucleo expansion boards
Offering peripheral functions

11System boards 
Exploiting application functionalities and their form factor 

Hardware code optimized

Cloud Service Mobile AppPC Software

Product evaluation 

example



Rapid prototyping with ODE environment 

STM32 Nucleo64 board

Blue NRG BLE expansion board 

M24SR NFC tag expansion board

X-NUCLEO-GFX01M2 Display expansion board

Heart rate sensor 



HW Ecosystem



Development tools overview

From full 

evaluation to 

open hardware

Flexible 

prototyping

Key feature 

prototyping

Full feature 

evaluation

STM32 Nucleo Discovery kits
Evaluation 

boards

Third-party 

boards

www.st.com/stm32nucleo www.st.com/stm32discovery

Functionality 

add-on

STM32 Nucleo 

expansion

www.st.com/x-nucleowww.st.com/stm32evaltools

Move Actuate Connect

Power Drive Sense

Translate

http://www.st.com/stm32nucleo
http://www.st.com/stm32discovery
http://www.st.com/x-nucleo
http://www.st.com/stm32evaltools


Ethernet ***

USB ***

ST Zio

(Uno extended)
***

Arduino Uno

ST morpho
** **

Arduino Nano *

STM32 Nucleo form choices

Nucleo-32

32-pin MCU

Nucleo-144

144-pin MCU
Nucleo-64

64-pin MCU



Nucleo expansion boards from ST

Translate

X-NUCLEO-IKS02A1
MOTION AND 

ENVIRONMENTAL SENSORS

X-NUCLEO-IHM01A1
STEPPER MOTOR DRIVER 

X-NUCLEO-IHM02A1 
TWO AXIS STEPPER MOTOR 

DRIVER 

X-NUCLEO-LED61A1
LED DRIVER

X-NUCLEO-IHM03A1
HIGH POWER STEPPER 

MOTOR DRIVER 

X-NUCLEO-IKA01A1
MULTIFUNCTIONAL EXPANSION 

BASED ON OPERATIONAL 

AMPLIFIERS 

X-NUCLEO-IHM05A1 
BIPOLAR STEPPER MOTOR 

DRIVER

X-NUCLEO-IHM04A1 
DUAL BRUSH DC MOTOR 

DRIVER

Motor drive

X-NUCLEO-NFC06A1
NFC CARD READER X-NUCLEO-IHM06A1 

LOW VOLTAGE STEPPER 

MOTOR DRIVER

X-NUCLEO-NFC04A1
DYNAMIC NFC TAG 

X-NUCLEO-IHM07M1
STEPPER MOTOR DRIVER 

X-NUCLEO-53L3A2 
PROXIMITY SENSOR 

X-NUCLEO-IHM16M1
THREE-PHASE BRUSHLESS

MOTOR DRIVER 

X-NUCLEO-CCA01M1
SOUND TERMINAL

Sensors and analog Communication

X-NUCLEO-PLM01A1
POWER LINE COMMUNICATION 

X-NUCLEO-GNSS1A1
ASSISTED GNSS

X-NUCLEO-CCA02M2
DIGITAL MICROPHONE

More references at www.st.com/x-nucleo

X-NUCLEO-AMICAM1
ANALOG MICROCHONE

X-NUCLEO-USBPDM1
USB TYPE-C

X-NUCLEO-SAFEA1
SECURE ELEMENT

X-NUCLEO-GFX01M2
GRAPHICAL DISPLAY 

http://www.st.com/x-nucleo


Nucleo boards for wireless communication

P-NUCLEO-LRWAN2

By ST and USI 

LoRaWAN® node & gateway

LRWAN2 frequency > 800 MHz,

LRWAN3 frequency < 500 MHz,

LoRaWAN-compliant protocol stack 
P-NUCLEO-LRWAN3

By ST and RisingHF

Long-range wireless node

Frequency range 150-960 MHz

LoRa, (G)FSK, (G)MSK, BPSK modulations

LoRaWAN, Sigfox-compliant protocol stack

Multiprotocol RF transceiver

Bluetooth® LE 5.2 and IEEE 802.15.4-2011 

compliant

NUCLEO-WB55RG

By ST

NUCLEO-WL55JC

By ST

https://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/stm32-nucleo-expansion-boards/p-nucleo-lrwan2.html
https://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/stm32-nucleo-expansion-boards/p-nucleo-lrwan3.html
https://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/mcu-mpu-eval-tools/stm32-mcu-mpu-eval-tools/stm32-nucleo-boards/nucleo-wb55rg.html
https://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/mcu-mpu-eval-tools/stm32-mcu-mpu-eval-tools/stm32-nucleo-boards/nucleo-wl55jc.html


Latest discovery kits

B-L072Z-LRWAN1B-U585I-IOT02ASTM32WB5MM-DK

STM32MP157F-DK2

B-L462E-CELL1

CLOUD

STM32G0316-DISCO STM32H735G-DKB-G474E-DPOW1

CLOUD

CLOUD

http://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/mcu-eval-tools/stm32-mcu-eval-tools/stm32-mcu-discovery-kits/b-l072z-lrwan1.html
https://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/mcu-mpu-eval-tools/stm32-mcu-mpu-eval-tools/stm32-discovery-kits/b-u585i-iot02a.html
https://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/mcu-mpu-eval-tools/stm32-mcu-mpu-eval-tools/stm32-discovery-kits/stm32wb5mm-dk.html
https://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/mcu-mpu-eval-tools/stm32-mcu-mpu-eval-tools/stm32-discovery-kits/stm32mp157f-dk2.html
https://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/mcu-mpu-eval-tools/stm32-mcu-mpu-eval-tools/stm32-discovery-kits/b-l462e-cell1.html
https://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/mcu-mpu-eval-tools/stm32-mcu-mpu-eval-tools/stm32-discovery-kits/stm32g0316-disco.html
https://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/mcu-mpu-eval-tools/stm32-mcu-mpu-eval-tools/stm32-discovery-kits/stm32h735g-dk.html
https://www.st.com/content/st_com/en/products/evaluation-tools/product-evaluation-tools/mcu-mpu-eval-tools/stm32-mcu-mpu-eval-tools/stm32-discovery-kits/b-g474e-dpow1.html


STEVAL-ASTRA1B
Asset tracking solution

STSAFE-A110
secure element which 

supports authentication and 

data secure management

TESEO LIV3F
best in class precision 

GNSS receiver module

STM32WB5MMG 
ultra-low-power, small form 

factor, certified 2.4GHz 

wireless module

ST25DV64K
Dynamic NFC/RFID tag IC 

with 64-Kbit EEPROM, and 

fast transfer mode capability

STM32WL55JC
long range wireless and 

ultra-low-power 

microcontroller

LSM6DSO32X
iNEMO inertial module: 32-g 

axl and 3D gyro with 

embedded ML Core and FSM

LIS2DTW12
Ultra-low power MEMS digital 

output motion and calibrated 

temperature sensor

STBC03
Highly integrated power 

manager, embedding a 

linear battery charger

TCPP01-M12
Single chip solution for USB 

Type-C port protection

STTS22H
Low-voltage, ultra-low-power, 0.5 

°C accuracy temperature sensor

LPS22HH
High-performance MEMS nano 

pressure sensor: absolute 

digital output barometer 

ST1PS02
Nano-quiescent 

synchronous step-down 

converter



Software ecosystem



Inside the STM32Cube ecosystem

Configuration

Development

Programming

Monitor

Packages

Expansions

Drivers

Middlewares

User application

Embedded SoftwareSoftware Tools

Save cost 

Save time 

Go beyond 

existing solutions

Easily monitor & 

debug applications



STM32CubeMX

Step 1: Select the microcontroller

• Through easy filtering capabilities

• Through selection of ST board you are using

Step 2: Configure the microcontroller

• Pinout wizard

• Peripherals and middleware wizard

• Clock tree wizard

• Power consumption wizard

Microcontroller configuration, step by step



STM32CubeIDE

History

FREE

Free for Commercial Development Eclipse/GCC Based Multi-OS Support



All-in-one programming software tool

– bootloader interface of UART

– IAP, ISP

– debug interface of JTAG/SWD

internal flash, ext. memory, 

option byte

STVP

Flash 

Loader

ST-Link 

Utility

DFUSe

– upgrade STLINK

– bootloader interface of USB

– IAP, ISP



All-in-one programming software tool

Command Line Interface
for Scripting

Option Bytes 
Program & Upload

Bootloader Interface Support
(USB, UART, SPI, I2C, CAN)

STLink Direct Support
(JTAG, SWD)

Trusted Package Creator
(secure programming)

Internal/External 

Flash Services



From ST-Link V2 to STLink-V3

ST-Link V2 STLink-V3

ST-LINK/V2-1

STLINK-V3SET

ST-LINK/V2

ST-LINK/V2-ISOL

STLINK-V3MINI

STLINK-V3MODS

Why upgrading : STLinkV3 has better performances, more features, and mods. 

B-STLINK-ISOL



STM32CubeMonitor

Monitoring application variables during runtime

• Non-intrusive tool to follow application behavior 

without interruption

• Real-time analysis to finetune application 

configuration

Drag & drop creation of dashboard UI

• Large choice of graphical components (gauges, 

bar graphs, plots...)

• Customize settings. No need for programming.

• Multi-OS tool: direct support of PC, tablets and 

smartphones

• Remote monitoring

Graphical visualization on any display



STM32Cube MCU Packages



STM32Cube Middleware

Generic MW

• FreeRTOS

• FatFS file system

• LwIP TCP/IP stack

• mbedTLS and mbedCrypto

• Open Bootloader

• ST Bluetooth 5 stack

• OpenThread stack

• ST 802.15.4 MAC

• Zigbee 3 stack

• STM32 WPAN

• TF-M

• ST USB Host & Device stacks

• STM32 Touch Sensing library

• STemWin graphics stack

One-stop-shop SW packages

www.st.com/stm32cubemcupackage

Peripheral drivers
HAL API

Hardware Abstraction Layer, highly portable and 

easy to use 

LL APIs

Low-Layer APIs, light weight and highly optimized 

for runtime efficiency

Dedicated MW

• LoRaWAN stack

• Sigfox stack

• Sub-GHz phy

• ST Key Management 

Services (KMS)

http://www.st.com/stm32cubemcupackage


STM32Cube Package Overview

• Single package

• Compatible with all STM32 

series

• Source code with open-source 

BSD license

Application benefits

Hardware Abstraction Layer  API Boards Support Packages

Drivers

HAL level examples

Board Demonstrations

Evaluation boards Discovery  boards Nucleo boards

Networking

LwIP TCP/IP  

& Polar SSL

File system

FATFS

Graphics

STemWin

USB 

Host & Device 

Middleware level examples

Middleware

RTOS

FreeRTOS

STM32 Series

STM3G0

CMSIS

Utilities

STM32F0 STM32F1 STM32F2 STM32F3 STM32F4

STM32L0 STM32L1 STM32F7

Low Layer Drivers

Low Layer Examples HAL + LL Examples

STM32L4



Adding Azure RTOS in the STM32Cube ecosystem

Configuration

Development

Programming

Monitor

Packages

Expansions

Drivers

Middlewares

User application

Azure RTOS ThreadX
Real-time operating system

Azure RTOS FileX 
FAT file system, fault tolerant

Azure RTOS NetX/NetX Duo
TCP/IP stacks

Azure RTOS USBX
USB stack, host and device

Azure RTOS

Production License for any STM32

Embedded Software Complemented with Microsoft Azure RTOSSoftware Tools

+



Expansions for various applications

Bootloader/Secure Boot

X-CUBE

X-CUBE-IAP-USART

X-CUBE-IAP-SD

X-CUBE-SBSFU

Safety

X-CUBE

X-CUBE-CLASSB

X-CUBE-STL

USB

X-CUBE

X-CUBE-USB-PD

Crypto

X-CUBE

X-CUBE-CRYPTOLIB

Audio

X-CUBE

X-CUBE-AUDIO

X-CUBE-VS4A

X-CUBE-USB-AUDIO

Sub-1G

X-CUBE

X-CUBE-SUBG1

BLE

X-CUBE

X-CUBE-BLE1

NFC

X-CUBE-NFC1

X-CUBE-NFC2

X-CUBE-NFC3

X-CUBE-NFC4

X-CUBE-NFC5

X-CUBE

LoRa

I-CUBE-LRWAN

I-CUBE

SigFox

X-CUBE

X-CUBE-SFOX

Enhanced for 

STM32 Toolset

Enhanced for 

STM32 Toolset

X-CUBE-BLE2 Enhanced for 

STM32 Toolset



Expansions with Function Packs

Cloud Motion

X-CUBE

FP

X-CUBE-CLD-GEN1

X-CUBE-AWS

X-CUBE-AZURE

X-CUBE-WATSON

X-CUBE-GCP

FP-CLD-AWS1

FP-CLD-AZURE1

FP-CLD-WASTON1

X-CUBE

X-CUBE-6180XA1

X-CUBE-IKA02A1

X-CUBE-MEMS-XT1

X-CUBE-MEMS1

X-CUBE-MEMS1-V4

FP

FP-SNS-6LPNODE1

FP-SNS-ALLMEMS1

FP-SNS-FLIGHT1

FP-SNS-MOTENV1

AI

X-CUBE

FP

X-CUBE-AI

FP-AI-SENSING1

FP-AI-VISION1

Enhanced for 

STM32 Toolset

Enhanced for 

ST Toolset



• X-STM32MP-IOT01A is the first 40-pin expansion

board under the umbrella of Open Development

Environment (ODE)

• The 40-pin expansion board is created for new

MPU platform from ST (STM32MP157F-DK2) &

inline with the specification from Raspberry Pi

HAT

X-STM32MP-IOT01A & X-LINUX-IOT01E/A

X-STM32MP-IOT01A

• X-LINUX-IOT01E/A is  a software package on for 

X-STM32MP-IOT01A expansion board on Yocto

Platform 

• An IOT Application where X-STM32MP-IOT01A 

expansion plugged on Discovery Kit act as 

gateway. The gateway fetches data from sensor 

node on Sub1-Ghz and send to the Cloud.

X-LINUX-IOT01E/A

https://www.st.com/en/evaluation-tools/x-stm32mp-iot01a.html#overview
https://www.st.com/en/embedded-software/x-linux-iot01e-a.html


Leading Graphics Performance

Drivers

Middleware

User application

Software

Tools

STM32H725STM32G0 STM32U5 

up to 480x272 to 640x480 up to 1024x768

New 

NeoChrom GPU

Drag-and-drop 

PC GUI-builder & -simulator



STM32 MCU Developer Zone

Everything for STM32 developers, in one place

www.st.com/stm32-mcu-developer-zone

https://www.st.com/content/st_com/en/stm32-mcu-developer-zone.html


STM32 Education and Support

Wide support for developer communities

community.st.com
FAE - Worldwide 

Customer Support

github.com/STMicroelectronics

Wiki.st.com/stm32mpu

wiki.st.com/stm32mcu 

STM32 Online Training

Textbooks

Partner training courses

Massive Open Online 

Courses

www.st.com/content/st_com/en/support/learning/stm32-education.html

https://medialib.st.com/?r=17566
https://www.st.com/content/st_com/en/support/learning/stm32-education/stm32-moocs.html
https://www.st.com/content/st_com/en/support/learning/stm32-education.html


Live demo 1: GPIO Toggling using Keil 
IDE 



• STM32CubeMX,  STM32CubeIDE & STM32Cube package is downloadable from 

www.st.com/stm32cube

• STM32CubeMX needs Java RE

• Check release notes of the particular version for additional requirements.

• Multiplatform tool runs on Windows, Linux and macOS

• Download from www.java.com/en/download/

STM32CubeMX installation

http://www.st.com/stm32cube
https://www.java.com/en/download/


1. Launch STM32CubeMX tool

2. The home page allows you 

to select the existing or 

recent projects or to create 

new projects.

3. Quick access to package 

installation and updates also 

available.

STM32CubeMX home page



• After the software package is 

launched, click on Help > 

Updater Settings (Alt+S)

• Configure the Updater Settings.

• Default repository folder is predefined 

but is user configurable.

• Enable/Disable the automatic check 

for updates in tab “Updater Settings”

Prerequisites: updater settings



• Configure the Connection 

Parameters

• By default, there is no Proxy need. 

If your computer needs to set a 

Proxy you can do it at     

Connection Parameter

• Specify the proxy server settings 

that are appropriate for your 

network configuration by selecting 

a proxy type among the following 

possibilities

Prerequisites: Updater Settings



• To download new STM32 

MCU packages, follow the 

steps below:

• Select     « Help > Manage 

embedded software 

packages » to open the 

Embedded Software Packages 

Manager 

• Click the      checkbox to select 

STM32L4 package then   

select      « Install » to start 

the download and installation 

Prerequisites: Installing STM32Cube MCU packages

1

2

3

1

2

3



• Select     « Board Selector » 

tab search for     « NUCLEO-

L496ZG » in Commercial Part 

Number

• Select    « NUCLEO-L496ZG 

» kit and click on    « Start 

Project »

Board Selection
1

1

2
2

4

3

3

4



• Click on    « Yes » to 

initialize all peripherals with 

their default Mode

• In    « Pinout and 

Configuration » tab clear

the pinout using « Pinout

> Clear Pinouts »

• Click    «Yes» to warning 

Set Up Clear Pinouts

1

2

3

1

2

3

4

4



• Click    « Categories > 

System Core > SYS » 

• Enable    « Serial Wire » in 

Debug

• PA13, and PA14 will turn 

to  GREEN.

Enable Debug Pins

1

2

1

2

3

3



• In Pinout view search    « 

PB14 » and then Left-click on 

the highlighted pin and set   

as    « GPIO_Output » to drive 

the LED

• Right-click pin PB14 and 

Enter User Label & give  

name    « LD3 » as on the 

board.

Enable GPIO Pin

1

1

2

2

3
3

Schematic



Clock configuration

• In    « Clock Configuration » 

tab Set HCLK (MHz) to    « 80

», then press Enter.

• Click OK when Clock Wizard 

message pop out to 

automatically find the correct 

clock sources

• The appropriate clock source 

and PLL values will be set 

automatically

1

2

1

2



• In Project tab    « Name 

project »  e.g

GPIO_Toggle

• Browse for project 

location

• Select    « MDK-ARM » 

toolchain

• Review the exact MCU 

type and library version

Code generation project settings

1

2

3

1

2

3



• Click on     « GENERATE CODE » 

at the top right corner.

• Select    « Open Project »

• Then    « arm KEIL » will open

Generate Code

1

2

3

1

2

3



Keil Project Window



• Browse the    « main.c » 

file in Project

• Add the user code to 

toggle GPIOs driving the 

LED to the specific    « 

USER CODE » 

BEGIN\END section in 

the main.c

• Ensure you save project

Add User Code 

HAL_GPIO_TogglePin(LD3_GPIO_Port,LD3_Pin); /* Toggle LED */

HAL_Delay(1000); /* 1000 ms Delay */

1

2

1

2



• Click     « Build/Rebuild » 

icon or    « Project > Build 

Target / Rebuild all target 

files »

• Build status (Error and 

warning) is display in  « 

Build Output » window

• Ensure that no errors and 

warning 

Build Project

1

2

3

1

2

3



Starting the Debugger

1



Run Application

Debug Toolbar to 

reset, run/stop, step 

in, step out option

• Click to Run (F5) the 

application and see 

output on LD3 of 

NUCLEO board.

1



Live demo 2: GPIO Toggling using 
STM32CubeIDE



• Open STM32CubeMX (.IOC 

file) of same project created in 

last project. 

• Navigate to Project Manger tab 

Generating Code for STM32CubeIDE

1

2



• Change Toolchain/IDE 

MDK-ARM to    «  

STM32CubeIDE »

• Uncheck    « Generate 

Under root » checkbox

• Keep other setting as it 

is 

Note: If you generate the code to 

generate Under Root may corrupt 

old generated project

Change project setting for STM32CubeIDE

1 

2
1

2



• Click on    « GENERATE CODE » 

at the top right corner.

• Select    « Open Project »

• Then    « STM32CubeIDE »            

will open

Generate Code

1

2

3

1

2

3



• Set the desired workspace folder for all 

the projects to be created by the 

STM32CubeIDE

• Click on     « Launch »

• STM32CubeIDE Welcome Page 

• The Welcome Page allows the user to 

quickly reach information regarding the 

product, and how to use it

• Can be reached any time via Help > 

Information Center

Launch STM32CubeIDE

1

1



• [Information Center] panel contains 

links to various information related to 

STM32CubeIDE.

• Close the [Information Center] panel

• C/C++ perspective will appear

• Please note that the content from the 

[Information Center] panel might take 

some time to appear. 

• Click on the highlighted button to open 

the Project Explorer. 

First STM32CubeIDE start



C/C++ Perspective

Project Explorer view

Outline view

Build analyzer view

Editor view



• Right click on project and click on     « Build 

Project »

• Build status is displayed in the Console 

window 

• Compile errors are displayed in the 

Problems window.

Build Project

1 

1 

2 

2 

3 

3 



Debug Perspective

Debug toolbar

Terminal view

Serial port output 

can be directed 

to this view

Fault Analyzer view

Display information if 

a system fault occurs

Breakpoint view

Existing breakpoints are 

shown or configured here

1. Restart

2. Resume

3. Suspend

4. Terminate

5. Terminate & Relaunch

6. Step Into

7. Step Over

8. Step Return

9. Instruction Stepping mode

1 2 3 4 5 6 7 8 9

SFR view

Peripheral registers 

contents are 

displayed here



• In Project Explorer right click 

on project and click on     « 

Debug as STM32 C/C++ 

Application »  to start the 

debugging 

Note: STM32CubeIDE can 

detect if the current ST-Link 

firmware on Nucleo board is old.  

In this case, follow the 

instructions to update the ST-

Link firmware. Once done, start 

the debug session again.

Starting the Debugger

1 

1 



Click Resume        to run application



Live Demo 3: Using X-Cube Package



Opening STM32CubeMX in STM32CubeIDE

• Double Click    « GPIO.IOC 

» file

• This will open the 

STM32CubeMx 

perspective 

• Switch between the 

perspective with their icons 

on top right corner 

1 

1 

2 

2 



• Click to     « Help > Manage Embedded 
Software Package » to install Package

• Search     « X-Cube-MEMS1 » and     « 

Install » it

Download and Install X-CUBE Packages 

1

2

3

• Note: If you 

downloaded 

package form ST 

site you can install 

from click From 

Local tab

4

1

2 3

4



• Diagram of «  IKS02A1 board »

Sensor IKS02A1 

IIS2MDC 

ISM330DHCX 

IIS2DLPC 

IMP34DT05 

Onboard

IIS2MDC

ISM330DHCX

IIS2DLPC

DIL24

Main Board 

Nucleo

Arduino UNO R3

I2C

3D accelerometer 

plus 3D gyroscope

3D magnetometer

3D accelerometer 

– Low Power

Digital 

omnidirectional 

microphone



Nucleo-L496ZG and X-NUCLEO-IKS02A1 

Pin connection

3.3V

GND

PB8(I2C SCL)

PB9(I2C SDA)



Configure communication

• Select    « I2C » in     « 

Connectivity » & Mode «  

I2C » 

• Manually select

PB8 as I2C1_CLK

PB9 as I2C1_SDA

• No change: use default 

(Standard 

Mode/100kHz)  
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2 

3 

1 

3 

2 



Adding Software Pack

• In Software Packs click     « Select 

Components »

• Select « X-CUBE-MEMS1 » > Board 

Expansion     « IKS02A1 »

1 

1 

2 

2 



• Select Software Packs

• Select STMicroelectronics X-

CUBE-MEMS1

• Activate Board Extension MEMS

• Configure Platform Setting : 

Select I2C1

Activate Board Extension MEMs

1 

2 

3 

4 

1 

2 

3 

4 



Generate Code using STM32CubeIDE

• Generate code by clicking 

on «Generate code icon »

• All related sensor drivers 

will be added to your 

workspace 

1 

2 

1 

2 



Adding code (main.c)

#include "iks02a1_motion_sensors.h"

IKS02A1_MOTION_SENSOR_Axes_t acceleration;
IKS02A1_MOTION_SENSOR_Axes_t angular_velocity;
IKS02A1_MOTION_SENSOR_Axes_t magnetic_field;

• Add header files

• Add sensor variable

1 

2 
1 

2 



Adding code (main.c)

IKS02A1_MOTION_SENSOR_Init(IKS02A1_IIS2DLPC_0 , MOTION_ACCELERO );
IKS02A1_MOTION_SENSOR_Init(IKS02A1_ISM330DHCX_0, MOTION_GYRO);
IKS02A1_MOTION_SENSOR_Init(IKS02A1_IIS2MDC_0, MOTION_MAGNETO);

IKS02A1_MOTION_SENSOR_GetAxes(IKS02A1_IIS2DLPC_0, MOTION_ACCELERO, &acceleration);
IKS02A1_MOTION_SENSOR_GetAxes(IKS02A1_ISM330DHCX_0, MOTION_GYRO, &angular_velocity);
IKS02A1_MOTION_SENSOR_GetAxes(IKS02A1_IIS2MDC_0, MOTION_MAGNETO, &magnetic_field);

• Add sensor 

Initialization code

• Add sensor read 

code
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1 

2 



Download and debug

1 

2 

3 

Right Click 

Debug application

Add variable to Live 

Expression

1 

2 

3 

Add Variables in 

Live Expressions



• Click on the GO icon to Run project:

Monitor sensor values 

X-CUBE Mem Checkpoint 2
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